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Document outline 

About the drawing protocol document 

Mumbai Municipal Corporation has planned to automate the building plan approval process by 

introducing AutoDCR system. AutoDCR software reads the CAD drawings submitted by architects 

and automatically produce the deviation report based on the control regulations prescribed by 

MCGM .  

The purpose of this document is to establish a set of guidelines to Architects for preparation of 

drawings to be submitted for taking Building Permission from MCGM, Uniformity in the process of 

drafting of the drawings to be submitted for approval is required for automation of building 

approval system by introducing AutoDCR system.  

The consultants/Architects should prepare the drawings keeping specific objects in specific layers 

with specific colors and text.  The layers required to be generated with explanation of what is 

required to be drawn on which layer is described in this document. This document serves as a 

source of information on obtaining level of consistency in drafting and approval process focuses 

on both the theoretical and practical description of process flow and protocol to be used while 

preparing drawings for submission at MCGM for Building Permission. The document explains use 

of PreDCR utility.  

 

 How to read this drawing protocol document? 

This document should be read in conjunction with the building bye-laws which will be applicable 

for approval of a proposal.  The reader of this document should have understood the applicable 

bye laws for scrutiny of a proposal. The reader should also be familiar with AutoCAD terminology 

and environment for better understanding of the system. It is more exploratory in nature than the 

specifications and contains sections to explain particular aspect of planning and designing.  
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Drawing pre-formatting utility (PreDCR) 

 

Overview 

AutoDCR is a unique and innovative approach to automate scrutiny of building proposals by 

reading CAD drawings. AutoDCR software needs preformatted drawings with some specifications. 

PreDCR is a software application used to create the architectural plan as per AutoDCR software 

requirements. It helps in standardization of drawings and helps in reducing time required for 

preparing submission drawings. It works under AutoCAD environment with additional menu & 

toolbar. 

 

Using PreDCR commands user can create all the required layers in one click. Once all the layers 

are created in the drawing user can use AutoCAD commands to draw entities on the 

corresponding layers with the help of PreDCR software. Short commands are provided to activate 

any layer in PreDCR. PreDCR also helps in correcting drafting errors in the drawing. At any time 

user can verify if the drawn entities are properly closed or not, if proper name text has been 

written inside all closed poly or not etc. PreDCR will highlight all the failed entities if any. 
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Aims & objectives 

To bring uniformity and standardization in submission drawing format. 

To create error free drawing by auto-correction of drafting errors. 

To Increase drafting speed and efficiency 

To reduce drawing data redundancy. 

To remove dimensioning and area calculation requirements from submission drawing format and 

auto-calculating areas in AutoDCR automatically.  

 

Salient features 

Automatically creating required layers in the drawing 
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Automatically creating and inserting entites of required size in the drawing: User can define size 

of entity and insertion point in the the drawing.PreDCR will create and insert entity in the 

drawing at specified location. 

 

Automatic insertion of required text in the drawing. 

 

 

Drawing cleaning, refinements of poly lines, text and closed entity verification will be done by 

PreDCR to eliminate drafting errors.  
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PreDCR verify and will highlight failed entities in verifications with detailed explanation and Auto-

Zooming. 
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Benefits of PreDCR 

1) Standardization of submission drawings-Brings uniformity & standardization in submission 

drawing format. This software will correct some minor drafting errors and also provide list of 

failed entities with Auto-zooming facility so that user can easily locate the failed entities in the 

drawing.  

2) Operational ease and convenience-Data redundancy is eliminated from the drawing. Only 

minimum required entities are to be drawn in the drawing as most of the data will be auto 

detected by the system from existing available data. 

3) Increased speed and efficiency-PreDCR facilitates Auto insertion of many drawing entities like 

parking, door windows etc of required size and number. Test auto-insertion facility saves text 

typing efforts. Auto-dimensioning and auto-calculation facility saves calculation efforts. Using this 

software user can create all the required layers at one click.    

4) Accuracy - Accuracy in area calculations is achieved. Preparing Calculation tables, showing 

dimensions in the drawing is not required.  

 

Drawing formats 

 

1) Conventional submission drawing format  

 

Conventional drawing submission format 
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2) As per PreDCR format specified by PreDCR  

 

 

3) After scrutiny of drawing using AutoDCR- 
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Protocol details 

 

PreDCR is a software application used to create the architectural plan as per AutoDCR software 

requirements. It works under AutoCAD environment with additional menu & toolbar. 

           Using PreDCR commands user can create all the required layers in one click. Once all the 

layers are created in the drawing user can use AutoCAD commands to draw layout plan. 

As per AutoDCR requirement all building items like proposed plot, proposed work should be drawn 

on the corresponding layers. Short commands are provided to activate any layer in PreDCR  

At any time user can verify if the drawn entities are properly closed or not, if proper name text  

has been written inside all closed poly or not etc. PreDCR will highlight all the failed entities if any. 

          PreDCR can be used to modify/make and verify the existing or new architectural plan as per 

AutoDCR software requirements. Users are free to use AutoCAD commands and or PreDCR 

commands to achieve the main purpose which is: 

Drawing the architectural plan in DWG format as per AutoDCR software requirements. 

For Automating the process of Development Control Regulations user/draughtsman/architect have 

to follow some specifications. The following are the list of specifications that the user should 

follow.  

Plot layout, detailed floor plan and building section for all the floors should be there in one AutoCAD 

drawing file.   

All building items like proposed plot, proposed work, proposed parking etc must be drawn using 

closed polyline. 

(i.e. Every entity must be closed LWPOLYLINE except Railway Line , Drain line, Water Line, Electric 

Line, Dead Wall and Ground level.).  

Building Sub-Items must be exactly inside of outer closed polygon as per their place 

in architectural plan. 

This means none of the edge or vertex of inside entity should be drawn outside its container entity.  

       For example Parking or Open Space poly must be exactly inside the main plot poly. 

       Tools are provided in PreDCR to verify this check.  

Every Building Sub-Items should be given a specific/unique name (Text or MText entity) on the same 

layer & inside the entity poly. If name not found then AutoDCR will generate the name 
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automatically. Naming Conventions should be followed properly. 

e.g.  Each Room should be given the concerned name Using <Assign Name> function of preDCR 

Living, Kitchen, Bedroom...Etc.  

Floor Name: GROUND FLOOR; TYPICAL FLOOR 1, 2 & 5-8; TERRACE FLOOR 

Floor Items: Room Names should be given properly without using abbreviations so the software 

can identify perfect entity. This can be done by Assign name facility provided by the software. 

User shall use only following kind of entities for Building Items: -  

LWPOLYLINE / TEXT / MTEXT 

If in a plan two proposed work are mirrored in that case user should provide two separate 

building plans for each proposed work. 

 

Installation and Registration 

System Requirements 

         Pentium IV or better (or compatible processor) 

         1 GB RAM (minimum) 

         Windows 98/2000/XP/7/8 {32 bit & 64 bit} 

         CD-ROM drive 

         AutoCAD 2000 and onwards 

 

Installation 

To install PreDCR software on your computer please follows the given steps.  

Step 1:  Insert the supplied PreDCR CD in CD drive of the computer. 

Step 2:  Run the PreDCR installer by double clicking on file "PreDCR_Installer.exe"  

in the PreDCR CD. 

Step 3:  Follow the next steps in installer wizard to complete installation.  
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After successful installation, a PreDCR shortcut will be placed on your computer desktop as  

shown below. 

 
Figure 1: PreDCR shortcut on desktop 

 

 

 

Methodology  

1)   Open the PreDCR software for clicking on PreDCR menu on your desktop & select the AutoCAD 

version & then click on "OK" button. 

 

 



 

21                      PreDCR User Guide : Municipal Corporation Greater Mumbai 

 

21 Methodology 

2)  First open submission drawing which is now converting in PreDCR format. 

3)  Save as your drawing with give some name. 

4) Check the scale by using Scale command. If drawing is not in 1: 100 scale then covert into the 1:100 

scale. & then make that drawing in metric scale if it is in other than meter.  

5) Also make the site plan in 1:100 scales.  

  

Click on PreDCR first tab to select the Type of Project that is " Proposed Development“ , “Land 

Division” or “Plotting Layout”, etc.  

a) If Plot is Already sanctioned & user have to take permission for the buildings only then select 

“Proposed Development.” 

b) If User having Proposal is Amalgamation or Subdivision then select “Land Division” option from the 

list. 

c) If Proposal having a Plotting Layout then select that “Plotting Layout” option from the list. 

d) If Proposal having compound wall or substructure permission then “Compound Wall/Substructure” 

option. 

 

 

Once you clicked on ok button software will show you following dialog. 
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8) Then u will get the list of PreDCR toolbar, then just click on "OK" button. Now all the Layers u will 

get in Layer Properties managers. 

9) User need to draw particular layer wise poly line and need to marked it accordingly. (Layer 

information is provided below)  

10) Once drawing is complete to draw then need to following process to verify currant drawing. 

 

11) Mark the margins by using Mark margin tab from from PreDCR tool bar.  

 

Front margin is automatically marked by system according to main access road. User need to mark 

side and rear margin only. 

 

 

 

12) When Mark margin is done, Click on "Verify Closed poly" option from Predcr tool. 



 

23                      PreDCR User Guide : Municipal Corporation Greater Mumbai 

 

23 Methodology 

 

 

Select all layers to verify it in proper format. 

 

 

 

 

13) When u will get these message "Entities on Predcr Layers are verified and found o.k." then only u 

can submit a softcopy of your drawing to the Corporation. 
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If all drawing is ok acceding to PreDCR then you will get following massage else will appear failed list. 

 

 

14)   If any failed entities are present, you see report by using "Failed list” tab. 

 

14)   You can check minimum entities are present on not in drawing according to selected type of 

project by using “Objection list” tab. 
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PreDCR Layer Information 

Layer: _Amalgamation 

Description : 

 Draw a continuous poly around the plots you want to   amalgamate. 

 Amalgamation contains more than one plot amalgamated    together. 
 All entities having amalgamation as their container entity should be uniquely present in each 
amalgamation.    

 I.e. suppose there is a road widening in the Plot then the poly of road widening should be 
different for each amalgamation. (For amalgamation, draw plot 1, plot 2, plot 3 on plot layer 
and amalgamated plot Amal Plot 1, on amalgamation layer overlapping plot  

Shortcut Command:  AML  

How to draw : 

Amalgamation:  
Following rules will be applied to Amalgamation layer 

 Name   

 Recreation ground   

 Amenity 

 Road Widening  

 Pathway  

 Internal road 

 Main road 

 Reserve area 

 NotInPossession 

 IntDPRoad 

 BLDGBLOCK(in layout)  

 ExStructure 

 Right-of-way 
Precautions to be taken –  

 Draw polyline correctly  

 Give name to this object in same layer as that of object.  

 If this polyline has not been drawn and named correctly then all above rules will not get 
checked. 
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Layer: _Amenity  

Description : 

Draw Amenity space as a closed polyline which is reserve for utilities, services and 

conveniences. 

Shortcut Command : AMN 

  

How to draw : 

Amenity 
Following rules will be applied on the objects of Amenity layer   

 Deduction  

 Addition  
Precautions to be taken – 

 Draw polyline correctly and give text on same layer. 

 If this polyline has not been drawn and texted correctly then rules will not get checked 
properly. 
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0 

 

 

 Layer: _ArchProj 

Description :  

This layer is used to represent various Architectural Projections in your Plan. Draw a closed 

Polyline for Architectural Projections. And mark it using Mark->Projection from PreDCR menu, 

according to requirements. 

Shortcut Command: AP  

How to draw : 

Architectural Projections: 
Following rules will be applied to of ArchProj layer 

 Width 

 Length  

 Depth  

 Area  

 Height 
Following entities should be drawn on same layer. 

 Chajja 

 Cornice  

 Whether Shade 

 Flower bad  

 Loft 

 Canopy  

 Porch  

 Rewas projection  
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 Steps 

 Otto 

 Garbage shaft  

 Refuge chute 

 Ornament projection  

 Ornamental Glazing 
Precautions to be taken –  

 Draw polyline correctly.  

 Provide Marking to each poly by using “Mark → Projection” from PreDCR Menu. 

 If this object has not been marked properly then it won't be checked.   

 

 

Layer: _ArtiVentiShaft 

Description :  

Draw Ventilation shaft/duct area as a closed Polyline with Text inside Outer Wall layer (BUA) on 

_ArtiVentiShaft Layer. Only those shafts to be drawn on same layer where ventilation taken for 

Non- habitable room. 

Shortcut Command:  AVD  

How to draw :  

ArtiVentiShaft: 
Following rules will be applied to ArtiVentiShaft layer 

 Area  

 Width 

 Deduction from BUA. 
Precautions to be taken –  

 Draw polyline correctly and give text on same layer.  
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 Layer: _Balcony 

Description :  

Draw Open/ Dry, Fire balconies as a closed polyline which is a horizontal projected to building 

line including parapet to serve as a sitting out place. Text of balcony must be inside and on 

_Balcony layer. 

Balcony must overlap with Outer Wall.  

Shortcut Command : BL   

How to draw :  

Balcony: 
Following rules will be applied for Balcony 

 Balcony width 

 Balcony to plot boundary distance.  
Precautions to be taken - 

 Draw a closed poly line and Mark it by using Balcony option from PreDCR Menu. 

 You can mark open / dry or fire balconies. 
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Layer: _Building 

Description : 

Building is used to group all floor plans of the same building.   Draw a closed poly enclosing all 

the floor plans and section of the same building on _Building layer. Note: As written above, 

dimension or area of this building poly has no meaning in AutoDCR. This is just a logical group of 

all floors of the same building. If the building plan of multiple PWorks or wings is same then 

building name shall be as given in table below. 

Building names can be. 

1  "A(Monarch)" PWork "A" has building plan "Monarch". 

2  "A,B(Monarch)" or "A&B(Monarch)" Wings A, B have same building plan 

"Monarch". 

3  "A-C(Monarch)" Wings A, B, C have same building plan 

"Monarch". 

4  "A1-A3(Monarch)" Wings A1, A2, A3 have same building plan 

"Monarch". 

 

Shortcut Command : BLD 

How to draw : 

Building: 
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Following rules will be applied on the objects of Building layer  

 Linking of each building with its proposed work which is available in plot boundary. 
Precautions to be taken – 

 Draw a closed poly line with peripheral of all entities of building including Floor plans, Section, 
Elevation, etc. properly and give text by using PreDCR Menu  Assign Name → Building & 
Proposed Work. 

 If  this polyline has not been draw and marking correctly then all above rules will not get 
checked        
 

Building poly area shall not be calculated for any area calculation. It is a reference to identify 

building details only.              

 

 

Layer: _BuildingLine 

Description : 

Draw a “_BuildingLine” as a closed poly line which area to be calculated for 

consumption of actual building line of that floor excluding cantilever projections. 

Shortcut Command : BDL 

How to draw : 

 Building Line: 
Following rules will be applied for Building Line 

 Coverage calculation 

 Margin calculation  
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Precautions to be taken - 

 Draw a closed poly excluding cantilever projection of the floor. 

 Draw column overlapping with it 

 

 

Layer: _BldgBlock (in layout) 

 Description :  

If you are getting permission for sub-division or amalgamation layout and containing building in 

it, then you need draw building periphery of that building on “_BLDGBLOCK” layer.  In this case, 

tentative block of building will refer just the presence of building in sub-divided or amalgamated 

Plot.  

 Shortcut command : BLDBLK  

How to draw :   
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 Layer: _Carpet area 

Description :  

Draw carpet area as a closed poly line which is a net usable floor area within a building 

excluding that covered by the walls or any other areas specifically exempted from floor 

space index computation in this regulation.  

Shortcut command: CPT 

How to draw :  

Carpet Area:          
Following rules will be applied to carpet area layer  

 Per Carpet Tenement number check required  

 Parking car, scooter, cycle  

 Tenement density  

 Water tank calculation 

 Sanitation  
Precautions to be taken – 

 Draw poly line correctly Give text to this object in same layer. 

 If this poly line has not been drawn and named correctly then all above rules will not get 
checked.       

 If more than one carpet area poly line containing in single tenement then need to mark it as 
split by using PreDCR Mark menu.   

 If slum development project then need to marked it as slam rehab, sale from menu. 
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 Projection affected portion (PAP) also can be marked from menu      

 

 

Layer: _Chowk 

Description :  

Draw a chowk as a closed poly line which is an enclosed space permanently open to 

the sky within a building at any level. From chowk we take ventilation for habitual 

rooms. 

Shortcut Command : CWK  

How to draw : 

Chowk : 

Following rules will be applied on the objects of Chowk layer 

 Area  

 Width 

 Deductions from BUA  
 Precautions to be taken – 

  Draw polyline correctly Give name to this object in same layer as that of object  

 If this polyline has not been drawn and named correctly then all above rules will not get 
checked.               
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Layer: _Column 

Description :  

Draw each column as closed poly line on “Column” layer inside parking floor as well as 

inside and overlapped with Building line layer in other floors. 

Shortcut Command : COL 

How to draw: 
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Layer: _CommOuterWallI 

Description:  

Draw a “_CommOuterWall” as a closed poly line which area to be calculated for BUA 

consumption including cantilever projections on that floor. This poly line to be used for 

commercial buildings. 

Shortcut Command : CMFS 

   How to draw: 

CommOuterWall:  
Following rules will be applied for the same.  
 Commercial built up area calculations 
 Permissible FSI commercial BUA in mixed use 
 Permissible architectural projection 
 Converge check  
 Use of building 
Precautions to be taken – 
 Draw a closed poly line correctly where commercial building is proposed.  
 Ploy line must be inside of _Floor layer. 

 

 

Layer: _Compound Wall 

Description :  

Draw closed poly line of compound wall to be drawn on proposed compound wall with 

text started with compound wall height. E.g. 1.5m. High Compound Wall 
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Shortcut Command : CW 

How to draw :  

Compound Wall: 
Following rules will be applied to Compound Wall 

 Height  
Precautions to be taken – 

 Draw a closed poly line correctly with containing text in it 

 Give name to this object in same layer as that of object.  
 

 

 

Layer: _CrzBoundary  

Description: 

CRZ boundary- Boundary of coastal regulatory zone shall be drawn on _CRZBoundary 

layer inside Plot boundary. 

Shortcut Command : CRZ 

 

How to Draw: 



 

38                      PreDCR User Guide : Municipal Corporation Greater Mumbai 

 

38 PreDCR Layer Information 

 

 

Layer: _DeadWall 

Description :  

Draw open polyline overlapping with proposed work on a side from where ventilation is not 
taken and should be draw inside the plot 

Shortcut Command : DW 

How to draw : 

Dead wall: 
Following rules will be applied to Dead wall layer  

 Margins  
Precautions to be taken – 

 Draw an open poly line correctly overlapping with proposed work. 

 Give name to this object in same layer 
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Layer: _Door 

Description :  

Door is a closed Polyline which is drawn on “_Door” layer. Also you can insert a 

particular size poly for Door using Insert->Door from PreDCR menu. 

Shortcut Command : DR 

How to draw :  

Door: 
Following rules will be applied to Door layer  

 Width 
 Depth 
 Height 

Precautions to be taken – 
 Insert poly line from Insert menu correctly   
 Text insertion point must be inside poly line.   
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Layer: _ElecLine 

Description :  

Electric line will be present in the layout plan and shall pass through plot entity as a 

non closed poly line. 

Name electric line shall start with its voltage capacity and text insertion point shall lie 

on its poly line. 

For e.g. 33 KV High Tension Line 

Shortcut Command : L1 

How to draw :  

Electric line: 
Following rules will be applied on the objects of electric line layer  

 Building distance check depend on 33kv high voltage & low voltage  
Precautions to be taken – 

 Draw an open poly line correctly and give text on same layer. 
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Layer: _Elevation  

Description : -  

Elevation to be drawn in _Elevation layer only for printing purpose. No regulations will 

be checked by reading this layer. The drawing on this layer need not be drawn using 

poly lines  

Shoutcut Command : EL 

How to draw : 

 

 

Layer: _ExStructure 

Description:  
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Draw a structure which already approved by authority on “_Exstructure” as a closed 

poly. And mark this as 'To be demolished' or 'to be retained’ by using Mark option 

from PreDCR Menu. 

Shortcut Command : EX 

How to draw :   

ExStructure:  
Following rules will be applied on the objects of Exstructure layer  
 Existing coverage area  
 Existing built up area  
Precautions to be taken –  
 Draw poly line properly and give a text and Mark “To be Demolished”  
 Mark it as “To be Retained” as “Building” Or “Structure” 

 

 

 

Layer: _ExtToiletDuct 

Discription:   

Draw an Outer toilet shaft area as a closed Polyline with Text inside Outer Wall layer 

(BUA) on “_ExtToiletDuct” layer. 
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 Layer: _Floor 

Discription: 

Draw a Floor as a closed poly line to the boundary of the lower surface in a story on 

which one normally walk in a building and including mezzanine floor also. The floor at 

ground level with a direct access to a street or open space shall be called the ground 

floor; the floor above it shall be termed as Floor 1 with the next higher floor being 

termed as Floor 2 and so on upward. For giving the name of each floor use the assign 

named option from the PreDCR menu. Also draw each floor separately. While giving 

name to the typical floor then use a typical option from Assigned name -> Floor name 

option from PreDCR menu bar. 

Shortcut Command : FLR 

Floor Name: - Floor name will be taken from text inside floor poly and on same layer. 

A floor plan is automatically associated/linked by AutoDCR software with one or more 

floor section poly in Section plan. This is done by matching name of Floor Plan and 

FloorInSection so both must be same. 

Typical Floor Non-Typical 

"TYPICAL" X "FLOOR PLAN"X: Floor numbers in 

specific format (, or & or -) 

X "FLOOR PLAN" 

X: Direct Floor's Name 

e.g.: 

TYPICAL 1,2 FLOOR PLAN 

TYPICAL 1-4 FLOOR PLAN 

TYPICAL 2&3 FLOOR PLAN 

e.g. 

GROUND FLOOR PLAN 

FIRST FLOOR PLAN 

SECOND FLOOR PLAN 

How to draw : 

Floor: 
Following rules will be applied on the objects of Floor layer  
 Containing all entities of floor  
 Corresponding check with its section 
Precautions to be taken –  
 Draw a closed poly line properly and give text by using Assign Name option from PreDCR 

Menu.  
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Layer: _FloorInSection 

Description :  

Draw a FloorInSection poly line as a closed poly of section boundary which contains all 

floors with stair cabin, Liftwell machine room, water tanks etc. as shown in the figure. 

Also write the name as "Section" in this section poly. 

In this closed poly of section draw sections of all floors with stair cabin, inner Chowk, 

Liftwell machine room, Ventilation shaft, water tanks etc. as shown in the figure. 

Also write the name as "Section" in this section poly. 

This section poly will present inside the building poly. 

Shortcut Command : SECF 

How to draw :  

Floor In section:  
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Following rules will be applied on the objects of Floor In section layer  
  Floor height  
 Terrace height  
 Plinth height 
 All Corresponding check 
Precautions to be taken – 
 Draw a closed poly line properly and give text by using Assign Name option from PreDCR 

Menu. 
 Floor and floor in section text must be link with each other. 

 

 

 

Layer: _Ground Level 

Description :  

Draw the Ground level line as open poly line in section .It is used for checking a total 

building height from this line. 

Shortcut Command : GL 

How to draw : 

Ground Level:  
Following rules will be applied on the objects of Ground level layer 
 Total Building  Height 
 Floor height from Ground level 
 Basement height from Ground level 
 Plinth checking 
Precautions to be taken –  
 Draw a open poly line correctly and give text on same layer   
 If this poly line is not drawn and texted correctly then all above rules will vary. 
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Layer: _IndOuterWall 

Description :  

Draw a “_IndOuterWall” as a closed poly line which area to be calculated for BUA 

consumption including cantilever projections on that floor. This poly line to be used for 

Industrial buildings. 

 

Shortcut Command: IFSI  

How to draw :  

Industrial Outer Wall: 
Following rules will be applied 
 Industrial built up area calculations 
 Permissible FSI Industrial BUA in mixed use 
 Permissible architectural projection 
 Converge check  
 Use of building 
Precautions to be taken – 
 Draw a closed poly line correctly where Industrial building is proposed.  
 Ploy line must be inside of _Floor layer. 

     



 

47                      PreDCR User Guide : Municipal Corporation Greater Mumbai 

 

47 PreDCR Layer Information 

 

  

Layer: _IntDPRoad 

Description : 

Draw existing or proposed D. P. (Development Plan) road or T. P. (Town Planning) Road when 
inside/intersected with plot. While giving name start text with road width. E.g. 15m wide D. P. 
Road. 

Shortcut Command : R3 

How to draw :   

Internal DP Road: 
Following rules will be applied  
 Width  
 Area  
 Margin  
 Deduction 
 Net plot area calculation 
Precautions to be taken –  
 Draw a closed poly line correctly and give text on same layer.   
 Give text with start of road width. 
 It should be intersect with main plot. 
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Layer: _InternalRoad 

Description :  

Draw internal road with text specifying its width and draw a center line on same layer with its 
line type center. 

Shortcut Command : R2 

How to draw :  

Internal road: 
Following rules will be applied   
  Width  
 Length  
Precautions to be taken – 
 Draw a closed poly line correctly and give text on same layer.  
 Give centre line in middle of closed poly line with line type Centre. 
 Give text with start of its width.  
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 Layer: _Liftwell  

Description :  

Draw a Lift well as a closed poly line which is a mechanically guided car, platform or transport for 
persons and materials between two or more levels in a vertical or substantially vertical direction. 
If fire Lift well is provided then use the marking of “Fire Lift well" option from Mark -> Lift well -> 
Fire Lift well. Fire Lift well means a special Lift well designed for the use of fire service personnel 
in the event of fire or other emergency. 

Shortcut Command : LFT 

How to draw :  

Lift Well: 
Following rules will be applied on the objects of Lift well layer  
 Lift well area  
 No of proposed common Lift  
 width 
 Capacity  
 Free from BUA 
 Taken in BUA  
 Hydraulic Lift  
 Car Lift  
 Fire Lift  
Precautions to be taken – 
 Draw poly line properly and give text to using mark option from PreDCR menu. 
 Mark it as Free from BUA if it is to be deducted, else will add in BUA. 
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Layer: _Location Plan 

Description :  

Locations plan if any to be drawn on this layer. This is only for reference. No verifications to be 
done by AutoDCR for this layer, it is required for printing purpose only. 

Shortcut Command : LCP 

How to draw :  
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Layer: _Main Plot 

Description: 

Draw a Plot poly as a closed polyline which is a parcel or piece of land enclosed by definite 
boundaries. A Plot will contain all Proposed Works (buildings, wings), open space, Internal Roads, 
Parking etc. The overall Plot Entity represent a Plan, AutoDCR refers it as 'Layout Plan'. The 
overall Plot Entity represent a Plan, AutoDCR refer it as "Layout Plan". 

Shortcut Command: PLT 

How to draw : 

Main plot: 
Following rules will be applied to main plot layer  
 Size plot area  
 Permissible FSI 
 Requirement of Amenity 
 Requirement of Recreational ground  
 Requirement of Internal road, etc. 
Precautions to be taken – 
 Draw a closed poly line correctly with text on same layer. 
 Provide Main access road overlapping with main plot. 
 Provide R.G, Amenity, reserve area, Road Widening, etc. inside Plot boundary 

 

 

Layer: _Main Road 

Description: 

Draw a Main Road as a closed poly line which is abutting the plot. On the site that road is any 
type of road. Such as any highway, street, lane, etc. over which the public have a rite of passage 
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or access or have passed and had access uninterruptedly for a specified period, whether existing 
or proposed in any scheme. Road name start with its width only. 

Shortcut Command : R1 

How to draw :  

Main Road: 
Following rules will be applied to main road layer   
 Main road Width 
 Front Margin 
 Building height  
 Access to plot 
Precautions to be taken – 
 Draw a closed poly line correctly with mentioning its width. 
 Draw it overlapping with main plot  

 

                                                 

Layer: _Margin Line 

Description :  

No need to draw Margin Line, Just use Mark Margin tool for it. This layer is not provided for 
users. AutoDCR uses '_MarginLine' layer for its own internal use. 

 

 Layer: _Nala-WaterCourse 
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Description :  

 Draw Nala-WaterCourse polygon on this layer and give Proposer text inside it. 

Shortcut Command : R4 

How to draw :  

Nala-WaterCourse: 
Following rules will be applied to Nala.  
 Deduction  from Plot 
 Nala to building Distance check  
Precautions to be taken –  
 Draw a closed polyline correctly and provide text inside it. 

 

 

  

 Layer: _NETPLOT 

Description :  

No need to draw NETPLOT. This layer is not provided for users. AutoDCR uses '_NETPLOT ' layer 
for its own internal use. 

Layer: _NDZ 

Description :  

No Development zone area if any inside plot to be drawn on this layer. And it should be drawn 
inside the plot with text on _NDZ layer. 
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Shortcut Command : NDZ 

How to draw : - 

NDZ:  
Following rules will be applied on the objects of NDZ layer  
 Reserve area 
 Deduction and additional in net plot area  
Precautions to be taken –  
 Draw a closed polyline correctly and provide text inside it.   

 

 
 

  

Layer: _NotInPossission 

Description : 

Plot area which is not in possession or which is not in proposal to be drawn as a closed polyline 
on this layer. 

Shortcut Command: NIP 

How to draw :  

Not In Possession:  



 

55                      PreDCR User Guide : Municipal Corporation Greater Mumbai 

 

55 PreDCR Layer Information 

Following rules will be applied to Not in Possession layer  
 Deduction from plot 
 Net Plot Calculations 
Precautions to be taken –  
 Draw a closed polyline correctly and provide text inside it.   

 

Layer: _Parking 

Description :  

Draw a parking poly as a closed polyline which is an enclosed covered or open area sufficient in 
size to park vehicles. This closed polyline shall contain a text on same _Parking layer. This text is 
treated as name of parking. Insert the parking by using an Insert-> parking option. 

Shortcut Command : PK 

Parking Name: 
This closed polyline shall contain a text on same _Parking layer. This text is treated as name of 
parking. 

  On this layer, you can group and insert any number of parking 

Parking Name 

Car Large CP-L 

Car Small CP-S 

Scooter SC 

Cycle CY 

Transportation vehicle TV 

Visitor's Large Car  VP-L 
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Visitor’s Small Car VP-S 

Visitor’s Scooter VSC 

Visitor’s Cycle VCY 

Ambulance AMB 

How to Draw :  

Parking:  
Following rules will be applied to Parking layer 
 No of Parking 
 Size of Parking 
 Type of Vehicles      
Precautions to be taken –  
 Draw a closed polyline correctly with text on same layer where stilt area is proposed. 
 Insert various type of parking’s from Insert option from PreDCR Menu 
 If this polyline has not been drawn and inserted correctly then no of proposed parking’s will 

not come proper.  

 
 

Layer: _Passage 

Description :  

A closed polyline on _Passage represents a passage. It is a common passage or circulation space 
including a common entrance hall. This closed polyline contain a text. This text must be on 
"_Passage" layer. This text is treated as name of closed polyline. 

Lift lobbies to be drawn on same layer and to be marked it as Paid by using mark option from 
PreDCR menu. 

Shortcut Command : PAS  

How to draw:  



 

57                      PreDCR User Guide : Municipal Corporation Greater Mumbai 

 

57 PreDCR Layer Information 

Passage: 
Following rules will be applied on the objects of Passage layer   

 Passage Width  

 Deduction from BUA 

 Addition in  BUA 
Precautions to be taken – 

 Draw a closed polyline correctly and mark it by using mark option from predcr menu... 

 If lift lobby / staircase lobby to be marked free from FSI as Paid. 

 Remaining Passage area to mark Taken in FSI. 

 

 

Layer: _Pathway 

Description :  

Draw Pathway as a closed polyline with text specifying its width.eg.1.5 m. wide pathway. 

Shortcut Command: R6  

How to draw : 

Pathway: 
Following rules will be applied on the objects of Pathway layer 

 Length 

 Width  
Precautions to be taken –  

 Draw polyline correctly   

 Give name to this object in same layer as that of object  

 If this polyline has not been drawn and named correctly then all above rules will not get 
checked  
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Layer: _PhasedProgram  

Description:  

Draw phased program outlines covering floor plans or buildings/pworks on '_PhasedProgram' 
layer inside plot or floor. Enter name/number of Phased program - 

  E.g. Phase-1, phase-2, phase-3, phase4 etc. 

Shortcut Command: POD 

 

Layer: _PrintAdditionalDetail 

Description:  

Apart from the layers specified by PreDCR, any other information which user wants to display in 
final approval print shall be drawn on _PrintAdditionalDetail layer  

  

Shortcut Command: ADET 

How to draw: 
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Layer: _Podium 

Description :  

Podium shall be drawn on '_Podium' layer as a closed polyline. Podium should be inside plot 
covering proposed works if any. 

Shortcut Command: POD  

How to draw : 

Podium: 
Following rules will be applied to Podium layer 

 Parking  

 between  podium to plot boundary Distance check 
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Layer: _PropWork 

Description :  

Proposed Work is a building profile/outline and shall be drawn inside plot. All detail Building 
plans (inside building polyline) of all PWork (inside plot polyline) is associated/linked 
automatically by Auto-DCR by matching its name. 

So for proper association it is required to follow specific standard as given. 

  XY (Z) 
  X is Wing name. 
  Y is wing number. 
  Z is Building name. 

For example if there are four wings A1,A2 & B1,B2 in building named "Monarch" then proposed 
work  names shall be - 

  A1 (Monarch), A2 (Monarch) 
  B1 (Monarch), B2 (Monarch) 

Reference Circle: All PWork polies must contain two circles (of any size) with its center on 
common point for whole building. First on layer of any FSI and second on Layer “_Floor”. These 
reference circles to be inserted from PreDCR -> insert-->Direction ref circles at the same location 
in all the floors as well as pwork in plot.  Usually they can be placed inside either Common 
Liftwell or Stair/Inner Chowk (because generally their location is same on all floors). Reference 
circles are used by the software for overlapping all floor plans. 

Shortcut Command:- PW 

How to draw : 

PropWork:  
Following rules will be applied to PropWork layer 

 Building location in Plot boundary   

 Coverage area 

 Building to Building distance  

 Propwork to parking distance  

 Electrical line distance 

 electric sub-station distance 

 Septic tank     

 covered garage distance  

  Rail line distance 
Precautions to be taken –  

 Draw poly line properly and assign name from PreDCR menu Assign Name option Building & 
PropWork. 

 If building and proposed work not linked properly then it will hamper to building rules. 
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Layer: _RailLine 

Description :  

Railway line shall be drawn as a non closed polyline with some text indicating gauge of rail line 
over it. 

Shortcut Command :  L2 

How to draw :  

RailLine:  
Following rules will be applied to Rail line layer  

 Gauge  

 Margin 
Precautions to be taken –  

 Draw polyline correctly   

 Give name to this object in same layer as that of object  

 If this polyline has not been drawn and named correctly then all above rules will not get 
checked  
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Layer: _Ramp 

Description :  

Draw a Ramp poly as a closed polyline in floor plans and/or plot and section. Naming convention 
for ramp is "---m. long and ---m. high ramp-1". Give unique name to each ramp. 

Shortcut Command : RP  

How to draw :  

Ramp:  
Following rules will be applied on the objects of Ramp layer  

 Width  

 Slope  
Precautions to be taken –  

 Draw polyline correctly   

 Give name to this object in same layer as that of object  

 If this polyline has not been drawn and named correctly then all above rules will not get 
checked  
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Layer: _Recreational Ground 

Description :  

 Draw Recreational Ground as closed polyline reserved as recreational space on this layer. With 
text on same layer. 

Shortcut Command:  OPS 

How to draw :  

Recreational Ground:  
Following rules will be applied on the objects of recreational ground layer   

 Balance plot 

 Deduction in area calculation   

 Minimum recreation ground  area  

 Plot area in side recreation ground  
Precautions to be taken – 

 Draw polyline correctly   

 Give name to this object in same layer as that of object  

 If this polyline has not been drawn and named correctly then all above rules will not get 
checked  
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Layer: _Refuge Area 

Description :  

Refuse area to be drawn in plan as a closed polyline with text on this layer. Overlapped with FSI 
layer but outside the FSI poly. 

Shortcut Command : RFGA 

How to draw :  

Refuge Area:  
Following rules will be applied on the objects of Refuge Area layer  

  Area  

  Width  

  Excess are to be count in BUA  
Precautions to be taken –  

 Draw polyline correctly   

 Give name to this object in same layer as that of object  

 If this polyline has not been drawn and named correctly then all above rules will not get 
checked 
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Layer: _RefuseChember  

Description :  

Refuse chamber to be drawn in plan as a closed polyline with text on same layer which should be 
inside of floor. 

Shortcut Command: RMB 

 

Layer: _RefuseChute  

Description :  

Refuse chute to be drawn in plan as a closed polyline with text on same layer which should be 
inside of floor. 

Shortcut Command: RFC 

 

Layer: _ReservArea 

Description :  
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Reserved area (Reservation area in Development plan) shall be drawn on this layer if present in 
proposal. This can be any area reserved for/by Authority for future. 

Shortcut Command : RSA 

How to draw : 

ReservArea:  
Following rules will be applied to Reserve Area layer  

 Reserve area 

 Deduction  
Precautions to be taken –  

 Draw polyline correctly   

 Give name to this object in same layer as that of object  

 If this polyline has not been drawn and named correctly then all above rules will not get 
checked 

 

 

Layer: _ResiOuterWall 

Description :  

Draw a Residential Outer Wall as a closed polyline which is the area covered by a building on all 
the floors. This polyline only used for residential use building or floor. This layer must be inside 
Floor poly. 

Shortcut Command : MFS 

How to draw :  

ResiOuterWall: 
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Following rules will be applied for the same.  
 Residential built up area calculations 
 Permissible FSI 
 Permissible architectural projection 
 Converge check  
 Use of building 
Precautions to be taken – 
 Draw a closed poly line correctly where commercial building is proposed.  
 Ploy line must be inside of _Floor layer. 

      

 

Layer: _Road widening 

Description :  

Draw a road widening polyline as a closed polyline which the plot area is going to the road, that 
area   should be drawn on this layer. It should be inside the plot polyline. 

Shortcut Command : R5 

How to draw :  

RoadWidening: 
Following rules will be applied to Road Widening layer  

 Calculation of net Plot 

 Widening of Road  
Precautions to be taken –  

 Draw a closed polyline correctly inside Main plot and give text on same layer. 
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Layer: _Room 

Description :  

A closed polyline on _Room layer represents a room. This closed polyline contain a text. This text 
must be on _Room layer. Room to be marked by assigning them names using Assign Name-> 
room option from PreDCR menu. 

Shortcut Command : RU 

How to draw :  

Room: 
Following rules will be applied on the objects of room layer   

 Room size  

 Width  

 Depth 

 Door  

 ventilation 

 Balcony 

 Projection 
Precautions to be taken – 

 Draw poly line properly and give name to this object from “Assign Name → “ROOM” 

 Room must be inside carpet area poly line and door and windows must be overlapped with it. 

 If it is Air-Conditioned room then can be marked by using Mark option from PreDCR menu. 
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Layer: _Right-of-way  

Description :  

Draw a closed polyline on “_Right-of-way” to represent a Right Of way and text inside it 
representing its width. Layer should be inside or intersecting with Plot poly 

Shortcut Command : ROW 

How to draw :  

Right-Of-Way: 
Following rules will be applied on the objects of Right-of-way layer 

 Width  

 Plot 
Precautions to be taken –  

 Draw polyline correctly  

 Give name to this object in same layer as that of object.  

 If this polyline has not been drawn and named correctly then all above rules will not get check. 
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Layer: _Sanitation 

Description :  

Draw any sanitation entities on this layer. (E.g., Kitchen sinks etc...) Mark those entities by using 
PreDCR -> Insert -> Sanitation. 

Shortcut Command : SNT 

How To Draw: 
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Layer: _Service Duct 

Description :  

Draw a closed polyline in floor plan, area is left for services shaft like Electrical ducts, Fire ducts, 
etc. to be drawn on “Service Duct” layer. 

Shortcut Command: SD 

How to draw : 

Service Duct: 
Precautions to be taken – 

 Draw a closed poly line on Service Duct layer with text on same layer. 

 It should inside floor plan 
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Layer: _Section 

Description :  

Draw a Section polyline as a closed poly of section boundary which contain all floors with stair 
cabin, Lift well machine room, water tanks etc. as shown in the figure. Also write the name as 
"Section" in this section poly. 

In this closed poly of section draw sections of all floors with stair cabin, inner Chowk, Lift well 
machine room, Ventilation shaft, water tanks etc. as shown in the figure. 

Also write the name as "Section" in this section poly. 

This section poly will present inside the building poly. 

Shortcut Command : SEC 

How to draw :  

Section:  
Following rules will be applied on the objects of Section layer  

 Name  

 All Floor in section  

 Ground level 

  Lift well height 

 Staircase cabin  

 Margin 

 Tenement number  

 Parking   

 Per floor area 

 Building height 
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 Water tank  
Precautions to be taken –   

 Draw polyline correctly  

 Give name to this object in same layer as that of object.  

 If this polyline has not been drawn and named correctly then all above rules will not get check. 

 

 

Layer: _Sewage Line 

Description:   

Drain Line shall be drawn as a open polyline on this layer. 

Shortcut Command : L5 

How to draw :   
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Layer: _Service Slab 

Description:   

Service slab to be drawn as a closed polyline on “_ServiceSlab” layer with containing text on 
same layer. 

 

Layer: _Site Plan 

Description:   

Site plan if any to be drawn on this layer. This is only for reference. No verifications are done by 
AutoDCR for this layer. So not compulsory. 

Shortcut Command: STP 

 

Layer: _SmokeVent 

Description :  

Smoke Vents are installed in buildings as an active fire protection measure. They are openings in 
the roof which are intended to vent the heat and smoke developed by a fire inside the building 
by the action of buoyancy. Such area to be drawn on “_Smoke Vent” layer as closed poly line. 

Shortcut Command : SMV 

 

Layer: _SpecialUseOuterWall 

Description : 

Building for all other uses like educational, institutional etc. except Residential, Commercial & 
Industrial use should be drawn on this layer. 

Shortcut Command : SUF 

How to draw :  

Special Use Outer Wall: 
Following rules will be applied for the same.  
 Special use built up area calculations 
 Permissible FSI commercial BUA in mixed use 

http://en.wikipedia.org/wiki/Active_fire_protection
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 Permissible architectural projection 
 Converge check  
 Use of building 
Precautions to be taken – 
 Draw a closed poly line correctly where commercial building is proposed.  
 Ploy line must be inside of _Floor layer. 

 

 

 

Layer: _Staircase 

Description :  

Staircase: On this layer, Each Staircase poly shall have three lines for Flight Width, Intermediate 
Landing and Floor Landing on same layer. Mark these open polyline by using Mark-> Staircase 
option from PreDCR menu. Also draw in plan all the treads on this layer which is a open 
polyline. 

This closed polyline contains a text. This text must be on _Stair layer. This text is treated as name 
of closed polyline. On this layer, Each Staircase poly shall have three lines for Flight Width, 
Intermediate Landing and Floor Landing on same layer This can be mark by tool Mark > 
Staircase > intermediate landing etc. 

Shortcut Command : STR 

How to draw :  

Staircase: 
Following rules will be applied on the objects of staircase layer   
 Staircase area  



 

76                      PreDCR User Guide : Municipal Corporation Greater Mumbai 

 

76 PreDCR Layer Information 

 Tread width 
  No. On Flight 
 Rise height  
 Staircase landings  
 No of Risers  
 Ventilation  
 Free from FSI (paid & unpaid) 
 BUA calculation 
 Access to floor  
Precautions to be taken –  
 Draw a closed polyline correctly and mark it by using Mark option from PreDCR menu. 
 Mark Stair case landings, flight width from PreDCR menu. 
 Mark stair case if it is free from FSI or taken in FSI. 

 

Layer: _SubDivision 

Description : 

 In Subdivision one plot is divided into more than one Subdivision. 
All entities having subdivision as their container entity should be uniquely present in all 
Subdivisions of a Plot i.e. suppose there is a road widening in the Plot then the poly of road 
widening should be different for each Subdivision (subdivided plot). 
Ex. Here Plot 1 is divided into three Subdivisions. And also the Road Widening is divided into 
RoadW 1 and RoadW 2 for each Subdivision.  

 (for subdivision, draw plot 1 on plot layer and subdivided plots like SubDiv 1,SubDiv 2 &              
SubDiv 3 on sub-division layer overlapping plot 1.) 

Shortcut Command : SBD 

How to draw :  

Subdivision: 
Following rules will be applied on the objects of Subdivision layer 
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 Name  
 Plot area  
 Recreation ground  
 Amenity 
 RoadWidening  
 Pathway  
 Internal road 
 Main road 
 Reserve area 
 Right-Of-Ways 
 NotInPossession  
Precautions to be taken –  
 Draw polyline correctly  
 Give name to this object in same layer as that of object.  
 If this polyline has not been drawn and named correctly then all above rules will not get 

checked. 

      

Layer: _SubStructure 

Description :  

Draw various substructures on "_SubStructure" layer as a closed polyline. And mark it according 
to the requirement as Mark -> Substructure -> Society Office, from PreDCR menu. Sub-
structures can be drawn inside plot or in floor plans. 

Shortcut Command : SSTR 

How to draw :  

Substructure:  
Following rules will be applied on the objects of Substructure layer  
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 Distance from building   
 Deduction or addition in BUA 
 Size of Substructure 
 Allowed in margin Front, Rear, Side 
 Distains from main road 
 Distains from Plot boundary 
 Distains from Building  
Precautions to be taken –   
 Draw polyline correctly. 
 Give name to this object from “Mark → Projection” option (From PreDCR Menu). 
 If this object has not been marked properly then it won't be checked.   

 

 

Layer: _SurrenderToCorpo 

Description :  

 In case of accommodation reservation, the plot area or FSI to be surrendered to MCGM is to be 
drawn on this layer with text inside it.  

Shortcut Command : STC 

 How to draw :  

Surrender To Corpo:  
Following rules will be applied on the objects of Surrender To Corpo layer  
 Depend on Gross plot area 
 Reserve area for mcgm 
Precautions to be taken –   
 Draw polyline correctly  
 Give name to this object in same layer as that of object.  
 If this polyline has not been drawn and named correctly then all above rules will not get 

checked. 
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Layer: _SurrenderToMhada 

Description : - 

In case of accommodation reservation, the plot area or FSI to be surrendered to MCGM is to be 
drawn on this layer with text inside it.  

Shortcut Command : STM 

 How to draw :  

Surrender To Mhada:  
Following rules will be applied on the objects of SurrenderToMHADA layer  
 Depend on Gross plot area 
 Reserve area for mcgm 
Precautions to be taken –   
 Draw polyline correctly  
 Give name to this object in same layer as that of object.  
 If this polyline has not been drawn and named correctly then all above rules will not get 

checked. 
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Layer: _Tank 

Description :  

A closed polyline on _Tank layer represents a water tank. Under Ground tank can be drawn in 
Floor or Layout plan. If it is drawn in Floor plan then it should be at bottom of GROUND FLOOR. 
Overhead tank can be drawn in TERRACE FLOOR. Tank should be drawn as per internal size or 
dimensions. Both the tank also draw in section also. 

Tank Name: - This closed polyline contain a text and must be in given format. This can also be 
done by tool Assign Name>Tank 

  Tank Name+ Type +Capacity 

Tank Type Text 

Overhead water tank (O/H) 

Underground water tank (U/G) 

  For e.g. 

  TANK-1 (O/H) 

  TANK-2 (U/G) 

Under Ground tank can be drawn in Floor or Layout plan. If it is drawn in Floor plan then it 
should be at bottom of GROUND FLOOR. 

Overhead tank can be drawn in TERRACE FLOOR. Usually it is drawn on Staircase poly in 
TERRACE FLOOR. 
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Shortcut Command : TNK 

How to draw : - 

Tank: 
Following rules will be applied on the objects of Tank layer 
 Tank area  
 Width  
 Depth  
 Capacity  
Precautions to be taken –   
 Draw poly line properly and give name to this object from “Assign Name → “TANK” Option? 
 If this polyline has not been drawn and named correctly then all above rules will not get 

check. 
 

 

Layer: _Temp Structure  

Description:  

 Area for temporary structures to be drawn as closed polyline with text on this layer  

Shortcut Command : TMPS 

How to draw :  

Temp Structure:  
Following rules will be applied on the objects of Temp Structure layer 
 Area check  
Precautions to be taken –  
 Draw polyline correctly  
 Give name to this object in same layer as that of object.  
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 If this polyline has not been drawn and named correctly then all above rules will not get 
checked. 

 

 

Layer: _Terrace 

Description:  

Draw a Terrace as a closed polyline on _Terrace layer which is including parapet wall. 

If Individual terrace having slopped, then slop shall be mentioned in its text. E.g.  1:5 slopping 
terrace, etc. 

Terrace can be present in:  

 Plot: It must overlap with Proposed Work 

 Floor: It must be outside the outer Wall. 

 

Shortcut Command : TER 

How to draw : - 

Terrace:  
Following rules will be applied on the objects of Terrace layer 
 Addition  
 AlterNet terrace  
Precautions to be taken –   
 Draw polyline correctly  
 Give name to this object in same layer as that of object.  
 If this polyline has not been drawn and named correctly then all above rules will not get 

checked. 
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Layer: _Tree 

Description:  

Draw or insert Tree in plot on _Tree layer if it is present in plot. 

User can be insert tree block directly by using predcr menu bar insert option. 

Shortcut Command: TREE 

 

Layer: _UpperSetBack  

Description : 

                   Draw a closed polyline in plan as well as in proposed work which having setbacks  

Shortcut Command : USB 

 How to draw :  

Upper Set Back: 
Following rules will be applied on the objects of Upper Set Back layer 
 Margin  
Precautions to be taken –  
 Draw poly line properly and give name to this object from “MARK → “UpperSetBack” Option? 
 If this polyline has not been drawn and named correctly then all above rules will not get 

check. 
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 Layer: _Void 

Description : 

If the space is not Chowk then it can be void. All ducts (where ventilation is not taken) and 
double height rooms can be drawn in void layer. If room is double heighted then void to be 
drawn on above of room at upper level floor. 

Shortcut Command  : VD 

How to draw :  

Void: 
Following rules will be applied on the objects of Void layer 
 Calculation of BUA 
 Double height of room.  
Precautions to be taken –  
 Draw polyline correctly  
 Give name to this object in same layer as that of object.  
 If this polyline has not been drawn and named correctly then all above rules will not get 

checked. 
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Layer: _WaterLine 

Description :  

Draw a Water line as an open polyline to show Water supply. 

Shortcut Command : WL 

How to draw :  
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Layer: _Window 

Description :  

Window is a closed Polyline which is drawn on "_Window" layer. Also you can insert a particular 
size poly for Window using Insert->Window from PreDCR menu. 

Shortcut Command : WND 

How to draw :  

Window: 
Following rules will be applied on the objects of Window layer 
 Width 
 Length  
 Height 
 Ventilation  
Precautions to be taken – 
 Draw polyline correctly   
 Give name to this object in same layer from “insert “option  as that of object  
 If this polyline has not been drawn and named correctly then all above rules will not get 

checked  
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Tools  

All/Remover Tool Tip (PDCRTOOLTIP): 

This command will activate the tool tips for PreDCR layers. 

Show Only DCR Layers (PDCRSPL): 

This command will turn off all the layers in the drawing except PreDCR layers.  

Show Only DCR Layers (PDCRSDL): 

This command will turn off all the layers in the drawing except DCR layers.  

Show Other Layers (PDCRSOL): 

This command will turn off all the DCR and PreDCR layers in the drawing. 

Show all layers (PDCRSAL); 

 This command will turn on all layers in the drawing. 

Calculate Total Area (PDCRCTA): 

This command will compute the total area of all selected closed polygons. 

 

 

Calculate Deducted Area (PDCRCDA): 

This command will compute the area of closed polygon after deducting closed polygons found inside. 
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Get All Inside Poly (PDCRFIP):  

This command will highlight all polygons, which found exactly inside selected polygon under test.  

Get All Overlapping Poly (PDCRGOP): 

This command will highlight all polygons, which are overlapping with selected polygon under test.  

Get All Intersecting Poly (PDCRGIP): 

This command will highlight all polygons, which are intersecting with selected polygon under test.  

Find Open Entities (PDCRFNDO):  

Highlight open entities on PreDCR layers. 

Find Closed Entities (PDCRFNDC):  

Highlight closed entities on PreDCR layer. 

 

Shortest distance (PDCRFSD):  

This command will find the shortest distance between two entities. 

Spelling check (_spell):  

This tool is used for spelling checking. 

Find Object (PDCRFOBJ):  

This command zoom & highlight object of a given handle. 
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Set Default ACAD Version (PDCRSDA): 

 

 

 

 



 

Commands 

Create New Project (PDCRNWP) 

This command will Create New project for current drawing. 

Here you have to select Type of Project as  

 Proposed Development. 

 

Note: It is always compulsory to add your drawing to new Project. 

 

Create AutoDCR Layers (PDCRCL):  

This command will create layers required for AutoDCR and as per the Project Type you have 

selected. 

Verify Drawing:  

This command will verify the current drawing as required by DCR specifications. 

 a) Verify Close Entities (PDCRVD): Verify that LWPOLYLINE entities on the selected layers are closed 

and contain one text. 
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B) Verify all drawing (PDCRVT): Use this command to verify the layout and building level objects in 

the current drawing plan.  

Major checks are as follows: 

 

In the "Verify All Drawing Dialog" you can select the layout or building objects to be checked. Then to 

view the result press OK button. PreDCR will start checking all corresponding objects in the currently 

open drawing and then display the status as OK or list of failed objects in the dialog as shown in 
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Figure. Failed Object Information.  

Check if these entities are drawn as closed LWPOLYLINE. 

Name text is given to all objects. 

Entities are placed exactly inside their parent objects (container). 

Naming conventions are followed properly. 

c) Objection List (PDCROLST): This command gives the list of all minimum required entities which 

are not there in your drawing. If all required entities found then it gives a message that “minimum 

required entities are present in drawing”. 

 

 Markings: 

 

Marking adds some extra meaning in entity. Following commands are provided to mark different   

entities as per requirement.  

Proposed Work:  

Centrally Air-Conditioned: If building is containing centrally Air-Conditioned then marked proposed work by 

using this menu. 

Normal: If by mistake proposed work is marked centrally Air-Conditioned then can be marked Normal by 

using this menu. 

 

Amenity:  

Surrendered: If Amenity area is surrendered to corporation then can be marked by using this menu. 

Normal: If by mistake Amenity is marked Surrendered then can be marked Normal by using this menu. 

 

Recreational Ground:  

Paved:  Mark Recreational ground area if it is paved by using this menu. 

Normal: Mark Recreational ground area if it is not paved by using this menu. 
 
Floor in Section:  

Slab Thickness: Mark slab thickness to Floor In section layer by using this menu. 

Beam:  Mark Beam to floor in section layer by using this menu. 

TDR: Mark TDR floor by using this menu. 

Read Widening: Mark Road widening area in floor in section by using this menu. 
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Normal: If by mistake floor in section is marked then can be marked Normal by using this menu.  

 

Stair Case:  

No of flight: 3, 4, flights: Mark stair case if it is greater than 2 flights accordingly. 

Fire Escape Staircase (PDCRSCFAB): Mark line inside staircase as a fire escape staircase 

Fab /Spiral Staircase (PDCRSCFAB): Mark line inside staircase as a Fabricated or spiral staircase.  

Free from FSI (Paid or Unpaid) (PDCRSCES): Mark free from FSI paid or unpaid 

Taken in FSI (PDCRSCES): Mark staircase taken in FSI.  

Open Staircase Free from FSI: Mark open stair case as free from FSI.  

Open Staircase Taken in FSI: Mark open stair case taken in FSI.  

 

 

Escalators: Mark stair case poly if Escalator is proposed. 

 

Stair case landing:  

Intermediate Landing (PDCRMIL): Mark line inside staircase as intermediate Landing.  

Flight Width (PDCRMFW): Mark line inside staircase as Flight Width. 

Floor Landing (PDCRMFL): Mark line inside staircase as Floor Landing.  

 

Lift: 

Normal (Default) Free from FSI or Taken in FSI (PDCRSCES): Mark Lift well poly line Normal Free from FSI 

or Taken in FSI accordingly. 

Fire Lift well (PDCRSCES): Mark Fire Lift well as a provided. 

Hydraulic- Free from FSI OR Taken in FSI (PDCRSCES): Mark Hydraulic as a Free from FSI OR Taken in FSI   

Car Lift- Free from FSI OR Taken in FSI Mark Car Lift as a Free from FSI OR Taken in FSI. 

  

Lift Machine Room: Free from FSI or Taken in FSI: Mark Lift machine room as a Free from FSI OR Taken in FSI   

 

Passage: 

Covered Passage: Free from FSI (PDCRPOCP): Mark a passage as a Covered passage Free from FSI  or taken 
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in FSI.  

Taken in FSI (PDCRPSUP): Mark passage as a taken in FSI.  

Open corridor (PDCRPSUP): Mark passage as a open corridor 

Fire Escape Passage : Mark Passage as Fire Escaped.  

Unmark (Default) (PDCRPSUP): Mark passage as a Normal Passage 

  

FSI (Outer Wall): 

Road Widening (PDCRCONES): Mark Residential or Commercial FSI as Road widening areas FSI. 

TDR (PDCRCONES): Mark Residential or Commercial FSI as TDR. 

Existing (PDCRCONES): Mark Residential or Commercial FSI as Existing FSI. 

Normal (Default) (PDCRUMFSI): Mark Residential or Commercial FSI as Normal FSI. 

          

Carpet Area: 

Splitted Tenement (PDCRMSPLTT): Mark Carpet Area as Splitted tenement. 

Rehab: Mark Carpet Area as a rehab and enter existing owner name, carpet area, common area, flat no, etc. 

Sale: Mark Carpet area as Sale. 

Project Affected Portion (PDCRMCPAP): Mark Carpet area if it is affected by projection (PAP).  

Normal (default) (PDCRMSPLTT): Mark Carpet Area as Normal (default)   

 

 

Room: 

A.C. Room or Normal default (PDCRMENCBL): Mark-> Room A.C.room or Normal (default). 

 

Balcony: 

Enclosed Balcony (PDCRMENCBL): Mark Balcony as enclosed balcony. 

Fire Balcony (PDCRMFB): Mark Balcony as Fire balcony 

Unmark (Default) (PDCRUMENCBL): Mark an open or dry balcony by using this menu. 

 

Terrace: 

Taken In FSI (PDCRMRTER): Mark Terrace as taken in FSI. 
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Normal (default) (PDCRMNTER): Mark Terrace as default. 

 

Column: 

Floating (PDCRMCF): Mark column if it is floating. 

Column (Default) (PDCRMCD): Mark column as default. 

 

Parking 

Tow stacked: Mark individual parking if it is two stacked. 

Three stacked: Mark individual parking if it is three stacked. 

Four stacked: Mark individual parking if it is four stacked. 

Five Stacked: Mark individual parking if it is Five stacked.  

Six Stacked: Mark individual parking if it is six stacked. 

 

Projection: 

F.Bed (PDCRMBPROJ): Mark Projection as Flower Bed. 

Chhajja: Mark Projection as Chhajja. 

Cornice: Mark Projection as Cornice. 

Whether shade: Mark Projection as Whether shade.  

Pargola: Mark projection as Pargola.  

Loft (PDCRMLPROJ): Mark Projection as Loft in floor plan as well as in section.  

Canopy (PDCRMCBPROJ): Mark Projection as Canopy    

Porch (PDCRMCPROJ): Mark Projection as Porch    

Revas Projection (PDCRMCPROJ): Mark Projection as a Revas Projection. 

Garbage shaft (PDCRMVPROJ): Mark Projection as a Garbage shaft.  

Ornamental Projection (PDCRMVPROJ): Mark Projection as a Ornamental Projection.   

Ornamental Glazing (PDCRMOPROJ): Mark Projection as a Refuse Chute. 

Otta (PDCRUMPROJ): Mark Projection as a Otta as a provided  

Steps (PDCRUMPROJ): Mark Projection as a Steps as a provided  
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Road Widening: 

Taken in FSI (PDCRMRVIFSI): Mark a Road widening area as a Taken in FSI  

 Unmark (default): Mark Road widening area as normal. 

 

Upper Setback: 

First upper setback (PDCRUMMR): Mark Upper setback as a first upper setback by using this menu 

Second upper setback (PDCRUMMR): Mark Upper setback as a Second upper setback by using this menu. 

 

Existing Structure: 

To Be Retained: Building or Substructure: Mark Existing structure layer as to be Retained Building or 

Substructure. 

To be demolished: Mark Existing structure as to be demolished. 

 

Substructure: 

Electric Meter Room (PDCRMER): Mark Substructure as an Electric meter room. 

Electric Sub-Station: Free from FSI or Taken in FSI   (PDCRMTRAN): Mark Sub Structure as an electric Sum-

Station ->Free from fsi or taken in fsi 

Watchman Cabin (PDCRMTRAN): Mark Sub Structure as a watchman cabin  

Society Office (PDCRMOR): Mark Sub Structure as a Society office. 

Servant Room (PDCRMSQ): Mark Sub Structure as a servant quarter. 

Servant Toilet (PDCRMSQ): Mark Sub Structure as a servant quarter. 

Sanitary Block (PDCRMSB): Mark Sub Structure as a sanitary block. 

Covered Garage (PDCRMGRJ): Mark Sub Structure as a covered garage when garage is covered. 

Open Garage (PDCRMGRJ): Mark Sub Structure as a Open garage 

Rain Water harvesting (PDCRMGRJ): Mark Sub Structure as a Rain Water harvesting  

A.C Plant Room (PDCRMGRJ): Mark Sub Structure as a A.C Plant Room 

AHU (PDCRMGRJ): Mark Sub Structure as a AHU 

Covered Swimming Pool (PDCRMGRJ): Mark Sub Structure as a Covered Swimming Pool 

Uncovered Swimming Pool (PDCRMGRJ): Mark Sub Structure as a Uncovered Swimming Pool  

Fire Control Room: Mark a substructure as a Fire control room. 
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Boiler Room: Mark a substructure as a Boiler room. 

Septic Tank/Soak pit (PDCRMGRJ): Mark Sub Structure as a Septic Tank/Soak pit   

Pump House: Free from fsi or taken in fsi (PDCRMPR): Mark Sub Structure as a Pump House Free From fsi or 

taken in fsi  

Effluent Treatment Plant/ STP (PDCRMETP): Mark Sub Structure as a Effluent Treatment Plant /STP 

Dish Antenna room (PDCRMSPT): Mark Sub Structure as a Dish Antenna room  

Well (PDCRMSPT): Mark Sub Structure as a Will  

Telephone Installation room Free from fsi or taken in fsi (PDCRMSPT): Mark Sub Structure as a Telephone 

Installation room Free from fsi or taken in fsi  

Entrance gate (PDCRMSPT): Mark Sub Structure as a Entrance gate 

Fitness center (PDCRMSPT): Mark Sub Structure as a Fitness center  

Suction Tank (PDCRMSPT): Mark Sub Structure as a Suction tank 

Pavilion (PDCRMSPT): Mark Sub Structure as a Pavilion  

Gymnasium (PDCRMSPT): Mark Sub Structure as a Gymnasium  

Club-House (PDCRMSPT): Mark Sub Structure as a Club-House  

Dust bin (PDCRMSPT): Mark Sub Structure as a Dust bin 

Milk/ Telephone booth-> Free from fsi or taken in fsi   (PDCRMSPT): Mark Sub Structure as a Milk/ 

Telephone booth-> Free from fsi or taken in fsi     

Letter BoxFree from fsi or taken in fsi (PDCRMSPT): Mark Sub Structure as a Letter Box-> Free from fsi or 

taken in fsi  

Chimney Free from fsi or taken in fsi (PDCRMSPT): Mark Sub Structure as a Letter Box-> Free from fsi or taken 

in fsi       

Welfare Hall: Mark a substructure as a Welfare Hall. 

BalWadi: Mark a substructure as a balwadi. 

Driver’s Rest Room: Mark a substructure as a Driver’s Rest Room. 

D.G. Set Room: Mark a substructure as a DG Set Room. 

Dispensary: Mark a substructure as a Dispensary. 

Store Room: Mark a substructure as a Store Room. 

Bank Locker/Safe Deposit: Mark a substructure as a Bank Locker or Safe Deposit. 

Meter Panel Room: Mark a substructure as a Meter Panel Room. 
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Change of Use: 

If use of any floor is changed then mark FSI polyline of that floor as change of use- changed use 

(e.g. residential, commercial etc) Draw FSI on changed use FSI layer (e.g if changing use from 

residential to commercial then draw FSI polyline on _CommFSI layer and mark FSI as change of use 

commercial.  

If use of entire building is changed then mark pwork similarly. 

Residetional (PDCRMFRESI): Mark FSI poly to change of use of floor as Residetional. 

Industrial (PDCRMFIND): Mark FSI poly to change of use of floor as Industrial 

Educational (PDCRMFEDU): Mark FSI poly to change of use of floor as Educational. 

Commercial (PDCRMFCOM): Mark FSI poly to change of use of floor as Commercial. 

Assembly (PDCRMFASM): Mark FSI poly to change of use of floor as Assembly. 

Institutional (PDCRMFINS): Mark FSI poly to change of use of floor as Institutional. 

Mercantile (PDCRMFMER): Mark FSI poly to change of use of floor as Mercantile. 

Govt/Semi-Public (PDCRMFGOVT): Mark FSI poly to change of use of floor as Govt/Semi-Public. 

Pvt. Business (PDCRMFPVT): Mark FSI poly to change of use of floor as Pvt. Business. 

Utility (PDCRMFUTL): Mark FSI poly to change of use of floor as Utility. 

Services (PDCRMFSER): Mark FSI poly to change of use of floor as Services. 

 
 

PropWork  

Residetional (PDCRMPRESI): Mark PropWork poly to change of use as Residetional. 

Industrial (PDCRMPIND): Mark PropWork poly to change of use as Industrial. 

Educational (PDCRMPEDU): Mark PropWork poly to change of use as Educational. 

Commercial (PDCRMPCOM): Mark PropWork poly to change of use as Commercial. 

Assembly (PDCRMPASM): Mark PropWork poly to change of use as Assembly. 

Institutional (PDCRMPINS): Mark PropWork poly to change of use as Institutional. 

Mercantile (PDCRMPMER): Mark PropWork poly to change of use as Mercantile. 

Govt/Semi-Public (PDCRMPGOVT): Mark PropWork poly to change of use as Govt/Semi-Public. 

Pvt. Business (PDCRMPPVT): Mark PropWork poly to change of use as Pvt. Business. 

Utility (PDCRMPUTL): Mark PropWork poly to change of use as Utility. 
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Services (PDCRMPSER): Mark PropWork poly to change of use as Services. 

 

Margin (PDCRMRGN): Use this command to define or mark the front, sides and rear margins of the plot. . 

 

 

Insert entities 

Parking 

Car L (PDCRICP): Use this command to insert car-parking poly of. At selected point.  

Car S (PDCRICP): Use this command to insert car-parking poly of. At selected point.  

Scooter (PDCRISP): Use this command to insert Scooter parking poly at selected point. 

Cycle (PDCRICY): Use this command to insert Cycle parking poly at selected point. 

Transport Vehicle (PDCRITV): Use this command to insert parking Transport Vehicle poly at selected point. 

Visitors Parking- Car -L (PDCRIVPL): Use this command to insert visitor large car parking poly at selected 

point 

Visitors Parking- Car -S (PDCRIVPS): Use this command to insert visitor small car parking poly at selected 

point 

Visitors Parking- Scooter (PDCRIVSC): Use this command to insert visitor scooter parking poly at selected 

point. 

Visitors Parking- Cycle (PDCRIVCY): Use this command to insert visitor Cycle parking poly at selected point 

Ambulance (PDCRIVP): Use this command to insert Ambulance parking poly at selected point 

Mini Bus: Use this command to insert Mini Bus parking poly at selected point 

Big Bus: Use this command to insert big Bus parking poly at selected point 
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Door (PDCRIDRNAM): Use this command to insert door poly at selected point and with specified size given by 

user. As soon as you use this command the following Dialog appears.   

 

Window (PDCRIWNDNAM): Use this command to insert window poly at selected point and with specified 

size given by user. 

 

Sanitation Text Use this command to insert sanitation text at selected point. Ex.  , Urinal, Wash basin 

Drinking water, washing tap, etc. which is mark on then insert text by using sanitation text marking from 

insert menu. 

Direction Reference Circle (PDCRIWC): Use this command to insert direction reference circle. Insert these 

circles in all the floor plans as well as in proposed work at the same & common place (e.g. Liftwell or Stair) of 

all the floors. 

North Direction (PDCRINND): Use this command to insert North Direction. Insert North Direction indicating 

the sides of your plot. You have to rotate this as per North Side.  

 

Stair Case Up/Dn Direction:  

UP (PDCRISDAUP): Use this command to insert showing direction of Stair Case way is UP. 
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Down (PDCRISDADN): Use this command to insert showing direction of Stair Case way is down.  

Building Template:  

You can insert building template by using this command as shown in below screen. 

 

Following template will automatic generate. 

 

 

Assign Name 

There are few naming conventions required by AutoDCR, for which PreDCR provides the following tools: 

 

Building and proposed works (PDCRBLDPWNL): Use this command to give name for building poly and its 

associated proposed works. 
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Tank (PDCRTNKNAM): Use this command to give name for Tank poly and its corresponding tanks. 

 

Fill in the dialog and select the tank poly drawn in plan and the same drawn in section 

 

Room (PDCRASRUN): Use this command to give different names for Room poly. 
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Floor Name (PDCRASFLRNAM): Use this command for assigning name to a floor poly and its corresponding 

floor in section poly in section. 

 

 

Tools  

All/Remover Tool Tip (PDCRTOOLTIP): 

This command will activate the tool tips for PreDCR layers. 

Show Only DCR Layers: 

All PreDCR layers (PDCRSPL): 

This command will turn off all the layers in the drawing except PreDCR layers.  

Building level layer (PDCRSBL): 

 This command will turn on all the building plan level layers in the drawing. 

Layout level layer (PDCRSLL): This command will turn on all the Layout plan level layers in the 

drawing. 

Show Only DCR Layers (PDCRSDL): 

This command will turn off all the layers in the drawing except DCR layers.  
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Show Other Layers (PDCRSOL): 

This command will turn off all the DCR and PreDCR layers in the drawing. 

 

Show all layers (PDCRSAL); 

 this command will turn on all layers in the drawing. 

 

Calculate Total Area (PDCRCTA): 

This command will compute the total area of all selected closed polygons. 

 

 

Calculate Deducted Area (PDCRCDA): 

This command will compute the area of closed polygon after deducting closed polygons found 

inside. 

           

Get All Inside Poly (PDCRFIP):  

This command will highlight all polygons, which found exactly inside selected polygon under test. 

  

Get All Overlapping Poly (PDCRGOP): 

This command will highlight all polygons, which are overlapping with selected polygon under test. 
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Get All Intersecting Poly (PDCRGIP): 

This command will highlight all polygons, which are intersecting with selected polygon under test. 

  

Find Open Entities (PDCRFNDO): Highlight open entities on PreDCR layers. 

 

Find Closed Entities (PDCRFNDC): Highlight closed entities on PreDCR layer. 

 

Shortest distance (PDCRFSD):  

This command will find the shortest distance between two entities. 

 

Spelling check (_spell): This tool is used for spelling checking. 

 

Find Object (PDCRFOBJ): This command zoom & highlight object of a given handle. 

 

Set Default ACAD Version (PDCRSDA): If you select by default any AutoCAD version and wants to use 

in another AutoCAD version then by using this command you can remove set default AutoCAD 

version option. 

 

 

PREDCR SHORT-CUT COMMANDS 

Layer name Description Naming Convention 
/Markings 

short 
command 

_Amalgamation Draw a continuous poly around the 

plots you want to amalgamate. 

Amalgamation contains more than 

one plot amalgamated together. 

All entities having amalgamation as 

their container entity should be 

uniquely present in each 

amalgamation. 

 AMLG 
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I.e. suppose there is a road 

widening in the Plot then the poly 

of road widening should be 

different for each amalgamation. 

(For amalgamation, draw plot 1, 

plot 2, plot 3 on plot layer and 

amalgamated plot AmalPlot 1, on 

amalgamation layer overlapping 

plot 1) 

_Amenity Draw Amenity space as a closed 

polyline which is reserve for 

utilities, services and 

conveniences. 

Mark -> Amenity -> 

Surrendered (If it is 

surrendered) 

AMN 

_ArtiVentiShaft  Draw ArtiVentilation shaft/duct 
area as a closed Polyline with Text. 
Inside FSIArea on _ArtiVentiShaft 
Layer. Only those shafts from 
which ventilation for habitable 
room is not taken should be drawn 
on this layer. 

 AVS   

_ArchProj This layer is used to represent 

various Architectural Projections in 

your Plan. Draw a closed Polyline 

for Architectural Projections. And 

mark it using Mark->Projection 

from PreDCR menu, according to 

requirements. Canopy/porch will 

come in plot & other projections 

will come with floor plans. 

 

Mark -> Projections -> 

Cheju, porch, loft, 

canopy, etc. 

 

AP 

_Balcony Draw a balcony as a closed polyline 

which is a horizontal projection 

including parapet to serve as a 

sitting out place. Name of balcony 

must be inside and on _Balcony 

layer. 

 

If Balcony is Enclosed 

Than 

Mark -> Balcony -> 

Enclosed Balcony 

BL 
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_Building Building is used to group all floor 

plans of the same building.   Draw 

a closed poly enclosing all the floor 

plans and section of the same 

building on _Building layer. Note: 

As written above, dimension or 

area of this building poly has no 

meaning in AutoDCR. This is just a 

logical group of all floors of the 

same building. If the building plans 

of multiple Works or wings are 

same then building name shall be 

as given aside. 

 

Naming Convention 

will be  

provided by 

Tool>Assign Name 

A (Bldg.Name) inside 

Bldg.Poly & 

A-1 (Bldg.Name) inside 

Pork Poly 

BLD 

_Building Line Draw a “_Building Line” as a closed 

poly line which area to be 

calculated for consumption of 

actual building line of that floor 

excluding cantilever projections. 

 BDL 

_BLDGBLOCK(in layout)  Description: - If you are submitting 

sub-division/amalgamation layout 

along with proposal for building 

permission also, then you should 

draw sub-div/amal. Layout on 

different drawing sheet and 

proposed building drawings on 

different drawing sheet. In this 

case, tentative block of building 

should be drawn on '_BLDGBLOCK 

(in layout)' just for referring the 

presence of building in sub-div. or 

amalgamation Plot    

 BLDBLK  

_Carpet area Draw carpet area as a closed 
polyline which is a net usable floor 
area within a building excluding 
that covered by the walls or any 
other areas specifically exempted 
from floor space index 

Mark-> Carpet area-> 

normal (default), 

Splitted, PAP, etc. 

 

CPT 
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computation in these regulations. 

 _Chowk Draw a chowk as a closed polyline 

which is an enclosed space 

permanently open to the sky 

within a building at any level. From 

chowk we take ventilation for 

habitual rooms 

 CWK 

_CommOuterWall Draw a Commouterwall as a closed 

polyline which is the area covered 

by a building on all the floors. This 

polyline mainly used for 

commercial use bldg. 

 

No need to give name 

on this layer. 

CMFS 

_Compound Wall Closed polyline of compound wall 

to be drawn on this layer 

overlapping plot.  

1.5m high compound 

wall 

CW 

_ CRZ Boundary  CRZ boundary Boundary of coastal 

regulatory zone shall be drawn on 

_CRZBoundary layer. 

 CRZ 

_Dead Wall  Draw open polyline overlapping 

with pwork on a side from where 

ventilation is not taken. And it 

should be drawn inside the plot. 

Mention height of 

compound wall in its 

text. 

DW 

_Door  Door is a closed Polyline Which is 

drawn on “_Door” layer. Also you 

can insert a particular size poly for 

Door using Insert->Door from 

PreDCR menu. 

 

Insert-> Door 

DR 

_Electric line 

 

 

 

 

Electric line will be present in the 

layout plan and shall pass through 

plot entity as a non closed polyline. 

   Name electric line shall start with 

its voltage capacity and text 

insertion point shall lie on its 

polyline. 

 

33 KV High Tension 

Line 

L1 
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_Elevation  Description:- Elevation to be drawn 

in _Elevation layer only for printing 

purpose. No regulations will be 

checked by reading this layer. The 

drawing on this layer need not be 

drawn using poly lines.  

 EL 

_ExStructure Draw an Exstructure as a closed 

polyline which is a building or 

structure existing authorized 

before the commencement of 

these regulation. And mark it using 

Mark -> Existing structure as 'To be 

demolished' or 'To be retained’. 

 

Mark-> Existing 

Structure-> To be 

Demolished    OR   

To be Retained       

ES 

_FloorInSection  Draw a Floor Inspection as a closed 
polyline which is the height of that 
floor (slab top to slab top) This poly 
only used for checking floor height. 
For assigning the name of 
FloorInSection then used 

Assigned name option for PreDCR 
tool menu. 

1. Name of each floor section will 
be same as of floor in plan. 

2. For one typical floor plan 
multiple floor section will be 
there. 

For e.g. for one typical floor plan 
for 1-3 floors there will three 
sections shall be drawn with name 
"First Floor Plan", "Second Floor 
Plan" and "Third Floor Plan" 
respectively. 

 SECF 

_Floor Floor poly should be drawn as a 

closed Polyline with Text on same 

Layer. This is just a logical Group of 

all floor Entities. 

           Floor Name: Floor Plan will 

be automatically link with Section 

Naming Convention 

will be  

provided by 

Tool>Assign 

Name>Floor name 

 

FLR 
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by matching the Floor Name. 

Hence all names to be given using 

<Assign Name> function 

Name of  floor should 

be in given format: 

TYPICAL-1,4 FLOOR 

PLAN 

TYPICAL-1-5 FLOOR 

PLAN 

TYPICAL-2&3 FLOOR 

PLAN 

Ground Floor Plan 

_Ground Level  The Ground level line should be 

drawn as an open polyline in the 

section poly. 

Proposed Height will be considered 

from Ground Level Polyline 

 

No need to give name 

on this layer. 

  

GL  

_IndOuterWall   Draw a closed FSI Polyline, which 

is used as a Industrial Purpose. 

No need to give 

Name on this layer.  

IFSI  

_IntDPRoad  Draw a DP Road as a closed poly 

line with Text. (e.g.  any DProad 

passing from inside of the 

plot)(Note: Road width must be 

written at the starting of Text). 

 R3 

_InternalRoad 

 

Draw each Internal Road as a 

closed Polyline with Centre Line 

(Ltype-CentreLine) & single text 

inside it. 

 

7.50 m wd. Internal 

Road 

R2 

_Liftwell 

 

Draw a Liftwell as a closed polyline 

which is a mechanically guided car, 

platform or transport for persons 

and materials between two or 

more levels in a vertical or 

substantially vertical direction 

 Fire Liftwell means a special 

Liftwell designed for the use of fire 

service personnel in the event of 

fire or other emergency. 

Naming Convention 

will be  

provided by 

Tool<Mark>Liftwell 

If fire Liftwell are 

provided then use the 

marking of " Fire  

Liftwell" option from 

Mark -> Liftwell -> Fire 

Liftwell. 

LFT 

_Location plan 

 

Location plans if any to be drawn 

on this layer. This is only for 

 LCP 
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reference. No verifications are 

done by AutoDCR for this layer so 

not compulsory. 

_Margin line  User need not do anything on this 

layer. 

Margin Polylines will 

be created by PreDCR 

by using Tool 

"Mark>Margins" 

L3 

_Main Plot 

 

Draw a Main Plot poly as a closed 

polyline which is a parcel or piece 

of land enclosed by definite 

boundaries. A Main Plot will 

contain all Proposed Works 

(buildings, wings), open space, 

Internal Roads, Parking etc. The 

overall Main Plot Entity represent a 

Plan, AutoDCR refers it as 'Layout 

Plan'. The overall Main Plot Entity 

represent a Plan, AutoDCR refer it 

as "Layout Plan".  

 PLT 

_Main Road 

 

 

Draw Main Road as a closed Poly 

with Text, which should be 

abutting with the Plot closed Poly. 

(Note: Road width must be written 

at the starting of Text) 

 

24.00 m wd. Main 

Road 

R1 

_Nala-WaterCourse Draw a closed Polyline on this layer 

and name of the poly should 

contain width of the Nala 

 R4 

_Net Plot No need to draw NETPLOT. This 

layer is not provided for PreDCR 

users. 

No need to give name 

on this layer. 

NPLT 

 

_NotInPossession  Plot area which is not in possession 

or which is not in proposal to be 

drawn as a closed polyline on this 

layer.  

 NIP  

_NDZ Draw a closed poly line on _NDZ 

layer with containing text on same 

layer, if any part of plot boundary 

 NDZ 
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containing NDZ area. 

_Parking  Draw a closed Polyline for Parking 

on “_Parking” Layer on stilt floor or 

podium floor. You need to Insert 

various sizes of parking from 

PreDCR menu. 

Insert-> Parking-> Car-

L/ Car-s/ Scooter/ 

Transport Vehicle/ 

Visitor Parking OR 

Ambulance, etc.  

 

 PK 

_Passage 

  

Draw a closed polyline on 

“_Passage” Layer with its text.  

(Note: If Premium for Passage is 

going to be Paid, Passage should be 

marked by using Tool "Mark " 

Mark > Passage > 

covered Passage.> Free 

from FSI or Taken in 

FSI. 

Mark > Passage > Open 

Corridor 

Mark > Passage > Fire 

Escape Passage  

PAS  

_Pathway  Draw pathway as a closed polyline 

with text specifying its width.eg.1.5 

m. wide pathway.  

 R6  

_Phased Program Draw phased program outlines 

covering floor plans or 

buildings/pworks on '_Phased 

Program' layer inside plot or floor. 

Enter name/number of Phased 

program - 

E.g. Phase-1, phase-2, phase-3, 

phase4 etc. 

 POD 

_PrintAdditionalDetail 

  

apart from the layers specified by 

PreDCR, any other information 

which user wants to display in final 

approval print shall be drawn on 

this layer     

 ADET 

_Podium 

 

Draw a closed polyline on 

“_Podium “to represent Podium. It 

should be shown in the layout and 

not in floor plans 

 

 

POD  

_PropWork PWork is a building profile and 

shall be drawn inside plot. Draw a 

closed polyline for Proposed Work 

Tools > Assign Name >  

Building and 

PropWork.  

PW  
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on “_Prop Work” Layer. 

_RailLine  Railway line shall be drawn in the 

layout plan as a Open Poly & Text 

which insertion point lies on the 

Polyline. (Note: Railway Gauge 

must be written at a starting of 

Text)  

 

_ Meter Gauge Railway 

Line  

L2  

_Ramp 

  

 Draw a Ramp as a closed polyline 

with Centre line (L-type-Centre) & 

Text inside it in Plan. 

10.0m long 1.5m high 

Ramp 

 

RP 

_RecrationalGnd  Draw Open space as closed 

polyline reserved as recreational 

space on this layer. With text on 

same layer. 

You can mark it as paved or normal 

by using mark option 

Mark -> Recreational 

Ground -> Paved OR 

Normal 

 

OPS 

_Refuge Area 

 

A closed polyline with Text around 

the refuge area should be drawn 

on same Layer. 

Refuge area should be outside 

overlapped with FSI (ResiFSI, 

CommFSI) poly. 

 RFG 

_Refuge Chamber Refuse chamber to be drawn in 
plan as a closed polyline with text 
on same layer which should be 
inside of floor. 

 RMB 

_Refuge Chute Refuse chute to be drawn in plan 
as a closed polyline with text on 
same layer which should be inside 
of floor. 

 RFC 

_ResiOuterWall Draw a ResiOuterWall as a closed 

polyline which is the area covered 

by a building on all the floors. This 

FSI polyline only used for 

residential use bldg or floor. 

No need to give name 

on this layer. 

MFS 

_Right-Of-Way  Draw a closed polyline on “_Right-

Of-Way” to represent a Right Of 

way and text inside it representing 

its width. Layer should be inside or 

 ROW  
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intersecting with Plot poly.  

_ReservArea If there in any Reservation Area in 

Plot, it should be drawn as a closed 

Polyline with Text inside same 

Layer. 

 RSA 

_Road Widening Road Acquisition/Road Widening 

area shall be drawn as a closed 

Polyline with Text on same layer 

inside Plot Entity. Margin will be 

generated & checked from Road 

widening Poly by AutoDCR 

software. 

 R5 

_Room A closed polyline for each room 

with its text inside should be 

drawn on this layer. Text should be 

given using <Assign Name> 

function 

 

 

Assign Name > Room 

RU 

_Sewage line  Drain/ Sewage line shall be drawn 

as an open polyline on this layer.  

 L5  

_Section Section poly should be drawn as a 

closed Polyline with Text on same 

Layer. It is used to group all 

Sectional detail like FloorInSection, 

Plinth, Stair cabin, Tank etc. 

(This is just a logical Group of 

Sectional Entity).  

(Note: Area or size of Floor doesn't 

have any meaning in AutoDCR) 

 

 SEC 

_Service Duct    

_Sanitation  Draw any sanitation entities on this 

layer. E.g. Urinals, Kitchen sink, 

Ablution Tab, Drinking Water, etc. 

PreDCR -> Insert -> 

Sanitation Text 

SND  

_Site Plan 

 

The encapsulating poly around the 

Site/Key Plan with the Text & Scale 

inside it.  

 

 

 

STP 
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_Smoke Vent. Smoke Vents are installed in 

buildings as an active fire 

protection measure. They are 

openings in the roof which are 

intended to vent the heat and 

smoke developed by a fire inside 

the building by the action of 

buoyancy. Such area to be drawn 

on “_Smoke Vent” layer as closed 

poly line. 

 SMV 

_Staircase Total Staircase area should be 

drawn as a closed polyline with 

text inside it. 

This Main Stair Poly should contain 

Intermediate Landing, Floor 

Landing & Each Tread as an open 

polyline. 

Intermediate & Floor Landing Poly 

can be Marked by PreDCR Tool 

"Mark>Staircase>Int. or Floor 

Landing" 

(Note: If Premium for Staircase is 

going to be Paid, Staircase should 

be marked by using Tool 

"Mark>Staircase>Free from FSI" 

 

Mark-> Stair Case-> 

Fire Escape Staircase 

OR Fab/Spiral Stair 

 Staircase  free from fsi  

paid/unpaid OR  taken 

in fsi 

Mark-> Staircase 

Landing-> Flight Width 

, Intermediate & Floor 

Landing 

STR 

_SpecialUseOuterWall A closed poly represents a other 

than Residential, commercial or 

Industrial use FSI or Floor FSI.  

It will cover whole area which is 

considered in FSI Area per Floor. 

 

 SUF 

_Subdivision In Subdivision one plot is divided 

into more than one Subdivision. 

All entities having subdivision as 

their container entity should be 

uniquely present in all Subdivisions 

of a Plot i.e. suppose there is a 

road widening in the Plot then the 

 SBD 

http://en.wikipedia.org/wiki/Active_fire_protection
http://en.wikipedia.org/wiki/Active_fire_protection
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poly of road widening should be 

different for each Subdivision 

(subdivided plot). 

_SurrenderToCorpo 

  

In case of accommodation 

reservation, the plot area or FSI to 

be surrendered to MCGM is to be 

drawn on This layer. With text 

inside it. 

 STC 

_SurrenderToMhada In case of accommodation 

reservation, the plot area or FSI to 

be surrendered to MCGM is to be 

drawn on this layer. With text 

inside it.  

 STM 

_Substructure Substructures which are allowed in 

Margins or Layout & Free from FSI 

should be drawn as a closed 

polyline with text inside it. 

Name of the 

Substructure can be 

assigned from 

Mark>Substructure 

tool. 

SSTR 

_Tank Tank clear size should be drawn as 

a closed Polyline with Text on this 

Layer in Floor Plan or Plot as well 

as Section with same Text. 

(Note: It should be in proper 

Naming convention which is 

Provide by Predcr by using Tool. 

Assign Name>Tank   TNK 

_Terrace Closed polylines around the 

terraces to be drawn on this layer. 

If the terrace is used commonly by 

all tenements mark it as Common 

Terrace else it will be treated as 

Individual by default. 

 TER 

_TempStructure  Area for temporary structures to 

be drawn as closed polyline with 

text on this layer.  

 TMPS  

_Tree Draw trees which are inside plot 

boundary in “_Tree” layer. 

You can insert tree blocks from 

Insert -> Tree TREE 
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PreDCR menu and Insert option 

_UpperSetback   Draw a closed polyline in plan as 

well as in proposed work which 

having setbacks  

 

 

USB  

_Void If the space is not Chowk then it 

can be void. All ducts (where 

ventilation is not taken) and 

double height rooms can be drawn 

in void layer. 

 VD 

_Water Line Draw an open polyline on 

“_WaterLine” to represent water 

lines. 

 L4 

_Window Draw a closed polyline on 

_Window” Layer to represent 

window. You can also use Insert 

tool to insert window poly for 

particular size. 

Insert > window WND 

 

 

Specifications to be followed-  

The drawing entities should be drawn on Automatic layers created by using PreDCR. 

Plot layout, detailed floor plan and building section for all the floors should be there in one AutoCAD 

drawing file.   

All building items like proposed plot, proposed work, proposed parking etc must be drawn using 

closed polyline. 

(i.e. Every entity must be closed LWPOLYLINE except Railway Line , Drain line, Water Line, Electric 

Line, Dead Wall and Ground level.) 

Building Sub-Items must be exactly inside of outer closed polyline as per their place in architectural 

plan. 

This means none of the edge or vertex of inside entity should be drawn outside its container entity. 

For example Parking or Open Space poly must be exactly inside the main plot poly. Tools are 

provided in PreDCR to verify this check.  

Every Building Sub-Items should be given a specific/unique name (Text or MText entity) on the same 
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layer & inside the entity poly. As far as possible, this name should be unique. If name not found then 

AutoDCR will generate the name automatically. Naming Conventions should be followed properly. 

e.g.  Each Room should be given the concerned name Using <Assign Name> function of PreDCR 

Living, Kitchen, Bedroom. Etc. Floor Name: GROUND FLOOR; TYPICAL FLOOR 1,2 & 5-8; TERRACE 

FLOOR. Floor Items: Room Names should be given properly without using abbreviations so the 

software can identify perfect entity. This can be done by Assign name facility provided by the 

software. 

User shall use only following kind of entities for Building Items: -  

LWPOLYLINE / TEXT / MTEXT 

If in a plan two proposed work are mirrored in that case user should provide two separate building 

plans for each proposed work. 
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Sample cases 

 

Residential Bldg (Row house) 

 

 

 Residential bldg. (Single Detached with two buildings) 
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Commercial building 

 

 

 Industrial Building 
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Special building (School bldg) 
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Meaning of various PreDCR Messages 

“Entity contain more than one text"  

      It means Entity on this layer contain more than one text. So remove the extra text. PreDCR 

need only one text for one entity. 

 

"Entity not contain any text"  

       It means this entity not having any name/text, so give the name to this   entity on this layer 

 

"Polyline is not in a proper format"  

        It means Highlighted polyline not drawn properly. So redraw that polyline & check the 

properties of that polyline. 

"Entity is not closed"  

       It means the highlighted entities not a closed polyline so close it by using 'pedit' command. 

 

"Entity is supposed to inside one of the following entities"  

       It means this highlighted entity should be present inside the one of the entities present in the 

given list“ 

 

"Entity is supposed to touching one of the following entities"  

      It means this highlighted entity is supposed to be touched one of the entities in given list 

 

"Entity should be outside overlapped with following entities“ 

      It means the highlighted entity should be outside overlapped with one of the th entities in the 

given list. 

“Entity must contain one of following entities“ 

      It means any one layer should be present inside in this entity which is listed. 

 

Following subentities are not found inside:  

     Direction Ref Point on layer _Floor, 
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    Type: BLOCK, Color: ByLayer Status: 

    Common Point on layer _ResiFSI, 

    Type: BLOCK, Color: ByLayer Status: 

    It means insert the direction reference circles in side of that entities. 

 

"The corresponding Building not found with same name"  

     It means that proposed work not having building with same name. So assigned that building with 

having same name of proposed work. 

"Mark Substructures using PreDCR mark Substructure tool"   

        It means mark the substructure by using mark -> Substructure menu.  Do not type substructure 

name manually. 

 

"The Liftwell machine room not found in building"  

        It means Liftwell machine room having name not same in Plan & in section. 

 

"The Liftwell poly is not suppose to be touch Liftwell machine room"  

        It means Liftwell machine room should be touch to Liftwell poly in the section. 

 

 ‘Invalid objects, Please Try again"  

        It means If user marking balcony as a enclosed   but selecting layer of terrace then this message 

are getting. If selected entity is incorrect then invalid objects message are showing. So select correct 

layer for particular of that layer marking only 

"Section not found"  

      It means If all the floor plans are drawn but one of them in section floor are missing to converting 

floor in section layer then this message are getting. So draw all the floor plans with floor in sections. 

 

"The corresponding entities not found in section"  

      It means that listed entities not present in the section so show that entities in the section. 
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"The corresponding entities not found in floor"  

      It means that listed entities not present in the floor so show that entities in the floor plan. 

 

“Two Tanks should not have same Name” 

      It means that two tanks not having a same name. So assigned two tanks by using Assigned name 

PreDCR menu. 

 

F.A.Q    (Frequently Ask questions) 

 

Hardware lock not found. 

1)   If user having Parallel port lock then they have to follow following steps. 

        Open My Computer -> C: Program files -> SEPL -> PreDCR -> Hlock 

        1.1. Open this Hlock folder & drvinstall -> click on install button & then click on Exit button. 

        1.2. Now open Checklock & click on check lock window. Check the return code & Description. If 

return code is 0 then u will get the Description is “ lock found” otherwise fixed the lock properly.& 

do the step 1.1again & check the lock. 

 

If user having serial port lock (its look like pen drive)  

       2.1  Plug the Sentry USB Lock to any of the available USB Port on the PC. 

       2.2 The Found NEW HARDWARE WIZARD will be displayed. Click NEXT to continue.  
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2.3.  Next window coming on screen will be of Choose your search and installation options in this 

window select the option Include this location in the Search. 
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2.4) Browse the correct path for the sentry USB driver (SentryUsb.sys) as e.g. C:\Program 

files\SEPL\PreDCR \ HLock  and click Next option. 

2.5) The next window you will get regarding waiting still installation after the installation is over the 

Next button will be highlighted click it. 
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2.6) Sentry USB device Drivers will be installed at this point Click Finish to complete the installation.  

 

 

2.7) Sentry USB Lock is now installed and ready to use. Sentry USB will be displayed in the Device 

Manager as below. 
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Internal error or Fatal error while verify the drawing 

     Copy that file and paste it into the new drg file & then verify. 

 

If Drawing is Automatically closed / crashed while marking any entity or verify complete drg. 

     Copy that file and paste it into the new drg file & then verify. 

 

 

 

While   performing verification if following massage comes, then follow the steps  

Check each layer separately until you found problematic layer   

 

 



 

PreDCR help manual: Municipal Corporation Greater Mumbai 

129 F.A.Q    (Frequently Ask questions) 

PreDCR Settings for Windows Vista Operating System 

                   

 Install  PreDCR from CD 

 After Installation,  “Right Click” on Desktop Shortcut of  Predcr OR AutoDCR I con & click on 
“Properties”  

 Select “Compatibility” option from “PreDCR” OR “AutoDCR Properties” dialog. 

 In that, Select “Run this program in compatibility mode for:” (from Compatibility mode 
option) & select Windows XP/Windows XP (Service Pack 3) option from List.  

 Select “Run this program as an administrator” check box. 

 

 

 Click on “Apply” button & then click “OK” 

 
This is only one time changes. 
Now PreDCR OR AutoDCR will run fine in Windows Vista 
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